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Overview
StatTrak for Basketball is a basketball statistics management system for 
league, tournament, individual teams, and table-top games.    Keeps records 
for up to 100 teams per directory (99 players per team).    Tracks team and 
player statistics, team record, game results, box scores, and team standings. 
All StatTrak reports can be computed for any combination of games.    You 
can design and save any number of    player statistics report formats, name 
additional categories, and sort on any category.    Reports can be printed or 
saved to disk.    This program is upgraded every year!

Unless this is a demo (shareware) version of StatTrak for Basketball, you 
must have either purchased it from an authorized retail outlet or directly 
from ALL-PRO Software.    Otherwise, you must immediately register with ALL-
PRO Software or delete the program.    See the Registration Section for 
registration details and benefits.
Start the program and select one or more teams.    Select Update from the 
Main Menu to update game and player results.    Player results can be 
entered from your score book or you can increment totals as the game is 
being played.    Select Reports from the Main Menu to display and print the 
team and player statistics, team record, game results, box scores, and team 
standings reports.
Back up your data regularly to protect against loss due to power failure, disk 
damage, or other mishaps.    This is very important!



First Game
To add your first game, select "Team 1", or another team,    from the list of 
teams.    Then from the Update Menu, select Team Name and assign the team
name, select Roster and add players to the roster, and then select Games 
and add the game and player results for the first game.    When adding a 
game, all game and player results are optional and can be added, changed, 
or deleted at a later time.
You might want to set up your game types (league ,tournament, practice, 
etc.), name additional categories you wish to track (double dribble is not a 
StatTrak category but you can name a category DD and then track it), name 
your positions (default is G, F, C, PG, PF but you can rename any of the five), 
and change your data directory before adding your first game.    Select Name
Your Own from the Options Menu to set up your game types, categories, and 
positions.    Select Data Directory from the File Menu to select the directory 
you want to store your team and player files.



Select Teams
StatTrak lets you select one or more teams on the team list.    If you select 
more than one team, only the first team selected on the list can be updated.  
However, you can report on more than one team at a time.    If you select 
more than one team, the Game Scores, Box Scores, and Record options on 
the Reports Menu will be disabled.    If you select just one team, the 
Standings menu option will be disabled.    The Players menu option is 
available regardless of how many teams you select.
To select multiple teams, click and drag on the team list.    The Shift+click or 
Shift+arrow key extends the selection from the previously selected item to 
the current item.    Ctrl+click selects or deselects an item on the list.



File
Selecting File from the Main Menu provides the following menu options:

Data Directory - Select team and player file directory.
Back Up Files - Back up team and player files.
Restore Files - Restore team and player files.
Exit Program - Exit StatTrak for Basketball program.



Back Up Files
Select Back Up Files from the File Menu to make a copy of your team and 
player files for your current working directory.    You might want to make a 
backup copy to a floppy disk and to your hard drive.    This way you have a 
backup copy you can quickly restore from on your hard drive and a copy on a
floppy disk that you can use should you ever experience problems with your 
hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Restore Files
Select Restore Files from the File Menu to load a backup of your team and 
player files to the current working directory.    You can restore from a backup 
made to a floppy disk or another directory on your hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Help
Select Contents... from the Help Menu to run the StatTrak for Basketball Help 
Program.    Select About from the Help Menu to view the About Screen which 
shows the version number of StatTrak for Basketball and the All-Pro Software 
address.



Reports
To display reports, select one or more teams, select Reports from the Main 
Menu, and then select one of the following menu options:

Players - Team and Player Statistics Report.
Game Scores - Game Scores Report (if one team selected).
Box Scores - Box Scores Report (if one team selected).
Record - Team Record Report (if one team selected).
Standings - Team Standings Report (if two or more teams selected).

ALL StatTrak reports can be computed for any combination of games (all 
games, last 10 games, games 5 through 10, league games, etc.) and can be 
printed or saved to a disk file.



Team and Player Statistics Report
Select    Players from the Reports Menu to display team and player statistics.  
The reports will show players from one or more teams depending on the 
number of teams selected.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.    Click Sort to sort the report on any 
category in ascending or descending order.    Click Format to select, add, 
change, or delete a report format; select the categories you want on the 
report in the left to right order you want them; select one category to create 
a category report.    You can create any number of report formats and save 
them to disk.    Click Player to display an individual's game by game 
statistics.    Click Minimum to divide the report into two groups based on a 
minimum number of games or field goal attempts.
Use the vertical and horizontal scroll bars to scroll up/down and left/right on 
the report.    The scroll bars will only appear if scrolling is needed.    For 
example, if only three players appear on the report, the vertical scroll bar will
not be visible.
See Team and Player Statistics for a list of all categories that can appear on 
the reports and how they're calculated.
To view career statistics for a player, select two or more teams and then 
bring up the Team and Player Statistics Report.    Then click Compute and 
enter a player's name or number and click OK. The report will display a 
statistics line for each team the player appeared in as well as a total line.    
For example, if Jeff Elwood played on the 1995 Warriors and the 1996 
Warriors, you would select both teams, bring up the Team and Player 
Statistics Report, and then recompute the report for Jeff Elwood to see his 
1995, 1996, and career statistics.



Game Scores Report
Select Games Scores from the Reports Menu to display game results for the 
selected team.    The report is only available if one team was selected.    The 
Game Scores menu option will be disabled if two or more teams were 
selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different games.      Click Short to display a one line 
game description which displays game number, game date, game type, 
opponents, and the score.    Click Long to display a more detailed game 
description which also shows the game location and a game comment.    Both
reports can be printed.



Box Scores Report
Select Box Scores from the Reports Menu to display the box scores for the 
selected team.    The report is only available if one team was selected.    The 
Box Scores menu option will be disabled if two or more teams were selected.
Field goals attempted-made, three point shots attempted-made, free throws 
attempted-made, rebounds, assists, personal fouls, and points scored for 
each player are displayed a game at a time for the selected team.    Click 
Next, Previous, First, and Last to scroll through the games one at a time.    
This report will be enhanced to include the opponents box score in a future 
version of StatTrak for Basketball.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Team Record Report
Select Record from the Reports Menu to display the won/lost record for the 
selected team.    The report is only available if one team was selected.    The 
Record menu option will be disabled if two or more teams were selected.
Games won, games lost, win percentage (Pct), points for (PF), and points 
against (PA) are displayed for each game type with recorded games and for 
total games.    Points for are the points the selected team has scored and 
points against are the points allowed by the selected team.    A column for 
ties will only be displayed if ties exist.
Win percentage in computed as ((wins + ties) / total games) where wins are 
1 point, ties are 1/2 point, losses are 0 points, and total games are 1 point 
per game.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Team Standings Report
Select Standings from the Reports Menu to display team standings.    The 
report is only available if two or more teams were selected.    The Standings 
menu option will be disabled if less than two teams were selected.
Teams are listed in order of winning percentage.    The report displays games 
won, games lost, win percentage (Pct), winning or losing streak (Streak), 
points for (PF), points against (PA), and games behind (GB) for each of the 
teams selected.
Points for are the points scored by a team and points against are the points 
allowed by a team.    A column for ties will only be displayed if ties exist.
Streak is the latest consecutive number of wins or losses by a team.    For 
example, if a team has lost its last 5 games then the Streak is "Lost 5".    If a 
team won its last game but lost the game before that, the Streak would be 
"Won 1".
Win Percentage is computed as ((wins + ties) / total games) where wins are 1
point, ties are 1/2 point, losses are 0 points, and total games are 1 point per 
game.    Note that a team could be listed first because they have the highest 
win percentage and still be 1/2 or more games behind.    For example, a 1-0 
team will be listed first but will be 1/2 games behind a 3-1 team.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.
To create team standings, game scores must be recorded for all teams 
selected.    ONLY GAME SCORES are needed to create standings.    Game date,
location, etc., are not needed.    Player results are also not needed.    
However, each team must be added to StatTrak.    If team X plays team Y, 
you must add a game for team X and add a game for team Y.    Games for 
both teams can not be added at the same time.    They must be added 
separately.



Compute Reports
From ALL StatTrak reports, you can click Compute to recompute the report 
using the following selection criteria on the Compute Screen:

*    Game Range - Any range of games from 1 to 999.
*    Game Types - Any combination of seven game types    (renamed from 

Name Your Own).
*    Fielding Positions - Check boxes for any combination of fielding 

positions.    Only available from Team and Player Statistics Reports
*    Starters/Bench - Check boxes for starters and non-starters.    Only 

available from Team and Player Statistics Reports
*    Special Select - Check box to use ONLY Special Selected games. Lets 

you compute for non-consecutive game numbers (i.e. 1,3,9).    You can 
Special Select games when updating a game on the Game Screen or by 
selecting games on the Compute Screen.    Selections are saved to disk.

*    Career Statistics - Enter player name or number to compute career 
statistics.    Only available from the Team and Player Statistics Report 
when two or more teams are selected.

Click All from the Compute Screen to reset parameters for computing all 
games.    Click OK to compute report.



Print Reports
All StatTrak reports (Players, Game Scores, Box Scores, Record, and 
Standings) can be printed or saved to a disk file.
When you print a report, you can either use the default report title or enter 
your own.    You can select from 1 to 50 copies and select the number of lines 
per page.    You can also select the font size for the report title and main body
of the report.    Some printers will not recognize font size but the report will 
still print.    Bold fonts can also be selected.    For the Team and Player 
Statistics Report you can choose to print just the top X number of players 
(i.e. League Leaders Report).
You can choose to create a report disk file instead of printing the report.    
Entering a file name will override printing.    You can specify a path with the 
file name and can either create a new report file, replace a report file, or 
append to an existing one.    Click Find... to search for a file.
Click Setup to bring up the Print Setup Screen to change print parameters 
such as Portrait or Landscape.



Update
To update team, player, and game information, select Update from the Main 
Menu and select one of the following menu options:

Games - Update team and player results.
Roster - Update player information on roster.
Team Name - Assign or change team name.
Change Player Number - Change player number.
Delete Files - Delete all data files (team name, roster, game 

results, player results) for the selected team.
A team must be selected before the menu options for Update are enabled.    
If more than one team is selected, only the first team selected on the team 
list can be updated.
* See also First Game.



Update Games
Select Games from the Update Menu to update game results.    The two 
components in updating a game are the Game Screen and the Player Screen.
General game information is (optionally) entered on the Game Screen and 
player results are (optionally) entered on the Player Screen.
After selecting Games from the Update Menu you will advance to the Game 
Menu.    Click Add Game to add a game.    Highlight a game on the Game List 
and click Change to change a game,    click Delete to delete a game, or click 
Insert to insert a game.    You can also double-click a game on the Game List 
to change it.    Clicking Add Game, Change, or Insert will take you to the 
Game Screen.      If you just want to update player results for a game already 
added, you can highlight the game on the Game List and then click Player 
Screen to go directly to the Player Screen.    When you delete a game, ALL 
player results recorded for that game will also be deleted (be careful)!
From the Game Screen, you can update game date, game location, 
opponent, points for (points scored by the selected team), points against 
(points allowed by the selected team), home team, Special Select, game 
type, and game comment.    All entries on the Game Screen are optional, 
except game type.    Click OK to update game results.    When adding or 
inserting a game, clicking OK will automatically take you to the Player 
Screen.    However, when changing a game, clicking OK will take you back to 
the Game Menu.    Click Player Screen to advance to the Player Screen when 
changing a game where you also want to update player results.
One of seven game types is selected for every game updated (defaults to the
first game type when adding a game).    Game types can be renamed by 
selecting Name Your Own from the Options Menu.    All StatTrak reports can 
be computed by game type.    For example, you could name game type 1 
LEAGUE and game type 2 PRACTICE.    Then you would select the LEAGUE 
game type when updating league games and the PRACTICE game type when 
updating practice games.    Then you could compute any report for only 
league games, only practice games, or both league and practice games very 
easily.
If you are tracking statistics or standings for two teams that played each 
other, you don't need to enter the same Game Screen information for both 
teams.    Add the game for one team first.    Then on the Game Screen for the 
other team select the opponent from the Drop Down List Box and then click 
Import to initialize the game information (date, location, points for, points 
against, game comment (optional), game type) from what was entered for 
the other team.
On the Game Screen you can check Special Select, which is used in 
computing reports.    For example, you could Special Select night games and 
then compute any report for night games.    You can also Special Select 



games from the Compute Screen.
The other component in updating a game is the Player Screen where 
individual player results are entered.    Entering player results is optional.    
You can always add results later.
Click on the Player Table to select a player to update.    The row clicked 
determines which player is selected.    The Stats Area for the player selected 
will be highlighted and the player name will be displayed on the right.    You 
can either enter player results by keying them in or by clicking +1 or -1.    
Using the +1 and -1 command buttons could be used to enter results as the 
game is being played.    A Basketball Icon on the Player Table indicates player
results have been entered.    Check Played in Game to mark appearance of 
player in game if no results need to be entered (you might want to give a 
player an appearance even though they didn't score, rebound, etc.).    This is 
important when game averages are computed by StatTrak.    Uncheck Played 
in Game to remove appearance of player in game and to zero all entry fields.
If you plan to enter player results real-time (as the game is being played), 
you should periodically save the player results and then return to the Player 
Screen for that game.    Results are not saved until you click OK on the Player 
Screen.    It's a little more difficult to update player results for two teams real-
time because you can only work with one team at a time.    However, a future
version of StatTrak for Basketball will address the issue.
When entering player results you can record results for up to five Name Your 
Own categories.    These category names can be changed by selecting Name 
Your Own from the Options Menu.
You can select a playing position when updating player results.    Playing 
position can be used when computing player statistics.    For example, you 
could compute statistics for all guards on the team.
Check Starter if the player started the game.    This can be used when 
computing player statistics.    For example, you could compute statistics for 
non-starters to see statistics for scoring off the bench.
Click Roster to add players to the roster.    The total number of players with 
results entered are displayed below the Player Table.
Click Team Totals to display the team totals.    This can be used as an auditing
tool.    Click Game Screen to go to the Game Screen.    Click OK to save all the
player results entered.    Click Cancel to cancel ALL the player results entered
(not the last player entered but ALL the players entered).    Clicking OK or 
Cancel will return you to the Game Menu.
See Team and Player Statistics for a list of all statistics that can be recorded 
and computed by StatTrak for Basketball.



Update Roster
Select Roster from the Update Menu to set up and maintain a team roster.    
Up to 99 players can be added for each team.    Select from the player list 
and enter or change the name, phone number, address, city, state, zip, and 
other player information.    Click Delete to delete a player name and related 
information from the roster.    Click Print to print the roster information.
Player names have an associated player number from 1 to 99.    One way to 
assign player numbers is to use the player's uniform number.    Currently, the 
only use of the player number is for computing career statistics.    However, 
career statistics can also be computed by player name.    The player number 
is used by StatTrak to identify players and does not appear on any reports.    
Deleting a player or changing a player name has NO effect on results 
recorded for that player number.    Player results relate to the player number, 
NOT the player name.
Don't get hung up on the player number.    It's a throw back from the DOS 
version of StatTrak for Basketball and will probably be eliminated in a future 
version of StatTrak for Basketball.



Update Team Name
Select Team Name from the Update Menu to assign or change a team name.  
You can assign a long team name and a short team name.    The short team 
name is only used on multiple team player statistics reports.    The long team 
name is used on all other reports and screens.    Click Default to assign the 
default team name based on the team number (i.e. Team 7).    You might 
want to include the year in the team name for documentation purposes (i.e. 
1993 Warriors).    This is especially helpful if you plan to record games for the 
same team in more than one year.
You might want to assign the team name before you set up the roster or add 
game results to make sure you're working with the correct team - the team 
name is listed on all update screens.    Changing the team name has NO 
effect on game and player results recorded for that team.    Game and player 
results relate to the relative team number, NOT the team name.



Change Player Number
Select Change Player Number from the Update Menu to move a player's 
name and statistics to another player number on the roster.    You can only 
change a player's number if NO results have been recorded for the number 
you want to change to.    This function could be used so a player has the 
same number every year for computing career statistics by player number.    
However, you can also compute career statistics by player name.
Player numbers do NOT appear on any reports.    Don't get hung up on the 
player number.    It's a throw back from the DOS version of StatTrak for 
Basketball and will probably be eliminated in a future version of StatTrak for 
Basketball.



Delete Files
Select Delete Files from the Update Menu to delete the team name, roster, 
game results, and player results for the selected team.    This function could 
be used to delete games that were added while experimenting with the 
program.
BE VERY CAREFUL USING THIS FUNCTION.    The team name, roster, 
game results, and player results recorded for the selected team will be 
permanently deleted!
Periodically make a backup copy of your game and player files.



Options
Selecting Options from the Main Menu provides the following menu option:

Name Your Own - Name your own game types, categories, and player 
positions.

The next version of StatTrak for Basketball will probably have an additional 
option to Create Your Own Statistics.



Data Directory
Select Data Directory from the File Menu to select the team and player file 
directory you want to work with.    Each directory can track up to 100 teams.
StatTrak will NOT make a directory for you.    You must do it.



Name Your Own
Select Name Your Own from the Options Menu to name game types, 
additional categories, and player positions.
With StatTrak every game is assigned a game type.    With Name Your Own 
you can name up to 7 game types.    For example, you could name game 
type 1 LEAGUE and game type 2 PRACTICE.    Then you would select the 
LEAGUE game type when adding league games and the PRACTICE game type
when adding practice games.    You could then compute statistics for league 
games by only selecting the LEAGUE game type on the Compute Screen, 
practice games by only selecting the PRACTICE game type, or league and 
practice games by selecting the LEAGUE and PRACTICE game types.    When 
computing reports, only the relative position of the selected game types are 
important, the names are just labels you assign.
You can also name up to 5 additional categories.    To track double dribbles, 
you could name a category DD and then record results under that heading 
when adding player results.    Then by selecting DD on the Format Screen, 
you could add double dribbles to the Team and Player Report.    Naming a 
category is for labeling purposes only.    Statistics relate to the relative 
position of the Name Your Own category, NOT the category name.
You can name up to 5 player positions.    StatTrak defaults to G (guard), F 
(forward), C (center), PG (point guard), and PF (power forward)    but you can 
rename them any way you want.    These player positions relate to computing
the Team and Player Report.    For example, you could compute statistics for 
all guards and point guards.    Statistics relate to the relative position of the 
player position, NOT the position name.
You might want to name your own game types, categories, and player 
positions before you start adding games.    However, you can name them at 
any time.



Team and Player Statistics
Below is a list of the statistics that are tracked and computed by StatTrak for 
Basketball:

2PM    2 Point Shots Made          ORb Offensive Rebounds
2PA 2 Point Attempts DRb Defensive Rebounds
3PM    3 Point Shots Made                  Stl        Steals
3PA 3 Point Attempts        Blk        Blocked Shots
FTM Free Throws Made                      PF        Personal Fouls
FTA  Free Throw Attempts TF        Technical Fouls
Ast Assists Min Minutes Played
TO Turnovers Dq Disqualified
BB1, BB2, BB3, BB4, BB5    User Named Categories (renamable)
G        Games                              = number of games played in
FGM Field Goals Made          = 2PM + 3PM
FGA Field Goal Attempts = 2PA + 3PA
FG% Field Goal Percentage = FGM / FGA
2P% 2 Point Percentage = 2PM / 2PA
3P% 3 Point Percentage = 3PM / 3PA
FT% Free Throw Percentage = FTM / FTA
Pts Total Points = FTM + (2PM * 2) + (3PM * 3)
Hi Game High = Highest Pts in a game
Reb Total Rebounds = ORb + DRb
FGG FG per Game = FGM / G
2PG 2 Pointers per Game = 2PM    / G
3PG 3 Pointers per Game = 3PM    / G
FTG Free Throws per Game = FTM / G
PPG Points per Game = Pts / G
AsG Assists per Game = Ast / G
TOG Turnovers per Game = TO / G
RbG Rebounds per Game = Reb / G
ORG Off Rebounds per Game = ORb / G
DRG Def Rebounds per Game = DRb / G
StG Steals per Game = Stl / G
BkG Blocked Shots per Game = Blk / G
MnG Minutes per Game = Min / G



Other Programs
Other Windows Programs available from ALL-PRO Software:

* StatTrak for Baseball $39.95 plus $3.75 s/h.
Works very much like StatTrak for Basketball!    Rated #1 by the Society 
for American Baseball Research (SABR).

* StatTrak for Soccer $39.95 plus $3.75 s/h.
Works very much like StatTrak for Basketball!

* ALL-PRO League Scheduler $49.95 plus $3.75 s/h.
Create round-robin schedules in minutes!
Handles division play and tracks scores and standings.

Other Windows Programs soon to be released by ALL-PRO Software:
Release Date

* StatTrak for Volleyball Fall of    1996
* StatTrak for Hockey Fall of    1996
* ALL-PRO Tournament Scheduler Early 1997

To order or for more information, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa).    International orders are welcome - call 608-271-1586!
Check out our Home Page (demos available for downloading):

http://www.msn.fullfeed.com/~allpro/
or Email us:

allpro@msn.fullfeed.com
Let us know what other features and sports programs you would like to see!



Registration
Unless this is a demo (shareware) version of StatTrak for Basketball, you 
must have either purchased it from an authorized retail outlet or directly 
from ALL-PRO Software.    Otherwise, you have an illegal copy and must 
immediately register with ALL-PRO Software or delete the program.
To register an illegal copy of StatTrak for Basketball, call ALL-PRO Software at 
800-SPORT-59 (MC/Visa) or send a check or money order for $39.95 + $3.75 
to ALL-PRO Software.    You will receive the latest version of StatTrak for FREE.
International orders please add $5 and send the check or money order in 
U.S. funds drawn on a U.S. bank.    Wisconsin Residents please add 5.5% 
sales tax ($2.20) for a total of $45.90.
To register a retail copy of StatTrak for Basketball, send the registration card 
or proof of purchase to ALL-PRO Software if you wish to receive the benefits 
listed below.    No fee is required.
If you obtained the program from ALL-PRO Software, you are automatically 
registered and will receive the benefits listed below.
Registration Benefits:

*    You will be notified when major upgrades to StatTrak for Basketball are 
released.    They will be offered to you at a reduced price.    The program 
is upgraded every year.

*    You will be notified when other programs are released or upgraded by 
ALL-PRO Software.

* You can receive FREE technical phone support at 608-271-1586.    Please 
don't call the 800 number which is reserved for orders.    Thank you!



Technical Support
For technical support:

* Call us at 608-271-1586.    Please don't use our 800 number which is 
reserved for orders.

* Fax us at 608-277-9195.
* Write us at All-Pro Software, 30 Maple View Court, Madison, WI 53719
* Email us at allpro@msn.fullfeed.com



License
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING ITS MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.      NEITHER ALL-PRO SOFTWARE NOR ANYONE ELSE 
INVOLVED IN CREATING, PRODUCING OR DELIVERING THIS SOFTWARE SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF USE OF THIS SOFTWARE OR INABILITY TO USE THIS 
SOFTWARE.      IN NO EVENT SHALL ALL-PRO SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE REGISTRATION FEE, REGARDLESS OF THE FORM OF 
CLAIM.    THE ENTIRE RISK AS TO QUALITY AND PERFORMANCE IS WITH THE USER.
THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF WISCONSIN 
AND SHALL INURE TO THE BENEFIT OF ALL-PRO SOFTWARE.    ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR 
RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL 
COURT OF COMPETENT JURISDICTION LOCATED IN DANE COUNTY, WISCONSIN.    THE
PARTIES HEREBY CONSENT TO JURISDICTION OF SAID COURTS. 
THIS SOFTWARE AND THE DISKS ON WHICH IT IS CONTAINED IS LICENSED SOLELY 
TO YOU ON A PERPETUAL BASIS FOR YOUR OWN USE. THIS IS COPYRIGHTED 
SOFTWARE.    YOU ARE NOT OBTAINING TITLE TO THE SOFTWARE OR ANY 
COPYRIGHT RIGHTS.    YOU MAY NOT SUBLICENSE, RENT, LEASE, CONVEY, MODIFY, 
TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, DECOMPILE, OR 
DISASSEMBLE THE SOFTWARE FOR ANY PURPOSE.    RECEIPT AND USE OF THE 
PRODUCT IS YOUR AGREEMENT TO THE TERMS OF THIS LICENSE.




